


به نام خدا

.دهیمآموزششمابهراایلاستریتوردرمختلفهایتایپ وگرافیساختآموزشداریمقصدایب وکای ندر

قدمبهدمقرازی رتایپ وگرافینوعسهآنازپسومی پ ردازیمآنکاربردهایوتایپ وگرافیتعریفبهابتدا
.دادخواهیمآموزش

blendسبکتایپ وگرافی.1

retroسبکتایپ وگرافی.2

comicسبکتایپ وگرافی3.
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تایپ وگرافی چیست؟

چاپ،دماننمختلفیصنای عدرتایپ وگرافیکلی،طوربه
ی رد،میگقراراستفادهمورد…وتبلیغاتنویسی،خوش
هرشسراسردرکهمختلفیبیلب وردهایتمامتقریبا

ازد،برده انب هرهتایپ وگرافیهنرازنوعیبهمیبینیم،
اتگرفتهمختلفشرکت هایبرقوپ رزرقتبلیغات

همگی،…وهااتوب وسرویبرسادهبعضانوشته های
.میایندحساببهتایپ وگرافیازنوعی
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تایپ وگرافی چیست؟
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.استریتصوی زبانیکبهرسیدنبرایتایپ،چیدمانهنر،تایپ وگرافی



کاربردهای تایپ وگرافی

کهگوناگونیکاربردهایبرعلاوهتایپ وگرافی
در،بردیمناممختلفصنای عبرایترپیش
بهشایانیکمکنی زگرافیکطراحیحوزه

ازرام،مونوگولوگوتایپ.میکندگرافیکطراحان
بهتایپ وگرافیهنرازاستفادهنمونه های

.میایدحساب
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6

…کنیمعشرو راآموزشیدورهکهآنستوقتکردیم،کسبتایپ وگرافیازکلیتعریفیککهحال





در ایلاستریتور blendآموزش تایپ وگرافی با ابزار

کاربردی تری نوب هتری نازیکیکهراBlendابزارباکاروایلاستریتوردرتایپ وگرافیمی خواهیمبخشای ندر
.دهیمآموزشاستنرم افزارای نابزار های

:داشتخواهیدنیازچی زهای یچهبهآموزشای نبرای

ایلاستریتورادوب یافزارنرم•

hiکلمه یتایپ وگرافیبرایشدهپی وستفای ل•

Playfairفونت• Display
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(باز کردن فای ل تاپی وگرافی)مرحلۀ اول 

1۸8۸ فای لای ناندازه ی.کنیـدبازایلاستریتورنرم افزاردروکردهخارجzipحالتازراشدهپی وستفای ل
RGBآنرن  گتایپب وده،پیکسل1۸8۸ درپیکسل موردوغی رچاپ یودیجیتالکارهایبـرایمناسب)

.است72piآنرزولوشنو(غی رهووبسایت هادراستفاده
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(نحوۀ ساخت استوانه رن  گی)مرحلۀ دوم 

اولقدم

Ellipseابـزارtoolbarقسمتاز Tool (L)انتخابرا
ه داشتنن  گ).بکشیددای ره ایوداشتهن  گهراشیفتدکمه ی.کنیـد
ضیبیوباشدکاملشمادای ره یتامیشودباعثشیفتدکمه
شماولیاست64pxمثالای ندردای رهایـناندازه ی(.نشود

رسم تربزرگیاکوچک ترراآنخودتانسلیقهبهبستهمیتوانید
.کنیـد

 1۸



(نحوۀ ساخت استوانه رن  گی)مرحلۀ دوم 

دومقدم

ازی رز شکلمانندوکنیـدانتخابراکردیدرسمکهدای ره ای
موردfillقسمتازوnoneموردoutlineقسمت

Gradientکنیـدانتخابآنبرایرا.
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(نحوۀ ساخت استوانه رن  گی)مرحلۀ دوم 

سومقدم

بهسفیدوسیاهحالتازمایدای رهGradientکهمیخواهیم
منویازراGradientپنلابتداکارایـنبرای.شودتبدی لرن  گی

Window > Gradientکنیـدباز.

یآب رن  گباراآنزی رمنویطب قوکردهانتخابراسفیدرن  گ
ستیدخواکهدیگریرن  گهرازمیتوانید.کنیدجایگزی نکمرن  گ

ارککردنپیداحجموشدنزیباتربـرایاماکنیـداستـفاده
رن  گوتی ره ترراستسمترن  گ.کنیداستفادهرن  گدوازنهای ی
.روشن ترچپسمت

۸۸۸۸FFو3CD9FF#رن  گ هایازمثالای ندر استفاده#
12.استشده



(نحوۀ ساخت استوانه رن  گی)مرحلۀ دوم 

چهارمقدم

رن  گوکنیـدرسمقبلدای ره یماننددیگریدای ره ی
79۸۸FF #وFF9BFF#بهبارایـنراآنهای

.دهیدتغیی ر

13



(نحوۀ ساخت استوانه رن  گی)مرحلۀ دوم 

چهارمقدم

رن  گوکنیـدرسمقبلدای ره یماننددیگریدای ره ی
79۸۸FF #وFF9BFF#بهبارایـنراآنهای

.دهیدتغیی ر
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Blendسوم نحوۀ استفاده از ابزار مرحلۀ 

اولقدم

Blendابـزار Tool (W)رویبرابتداوکردهانتخابرا
.نیـدککلیکبنفشدای ره یرویبرسپسوآب یدای ره ی
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Blendسوم نحوۀ استفاده از ابزار مرحلۀ 

دومقدم

ولیودشبالاشکلماننداستممکننی زشمانتیجه
با.تاسزیادبسیاردای ره هافاصلهمیبینیدکههمانطور

نیمککمهارافاصلهای نمیخواهیمتغیی راتسرییک
.آیدبدستیکدستورن  گیاستوانهیهتا

برسپسوکردهانتخابراشکلابتداکارایـنبرای
بازپنجره یدروکنیدکلیکدابلBlendابـزارروی

رویبرسپسوکردهاعمالرازی رتغیی راتشده
16.کنیـدکلیکokدکمه ی



Blendسوم نحوۀ استفاده از ابزار مرحلۀ 

سومقدم

هبراقبلقدمدرشدهساختهرن  گیاستوانه
منوازوکردهانتخابتایپ وگرافیهمراه

Object > Blend > Replace Spineانتخابرا
وانهاستباتایپ وگرافیکهدیدخواهید.کنیـد

.میشودجایگزی ن
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Blendسوم نحوۀ استفاده از ابزار مرحلۀ 

چهارمقدم

Directابـزارازاستـفادهبا Selection Tool
(A)باوکردهانتخابدلخواهبههارادای رهازیکی

وCtrl+Cترکیب یهایدکمهازاستفاده
Ctrl+Vنقطه یعنوانبهوکنـیدکپ یآنرا

.کنـیداستفادهiحرف
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Blendسوم نحوۀ استفاده از ابزار مرحلۀ 

پنجمقدم

Rectangleابـزارازاستفادهبا Tool (M)
نآرویبرسپس.کنـیدرسممشکیمربعی
Arrangeمنویازوکردهراستکلیک > Send

to backنیدکتبدی لتصوی رگراندبکبهراآن.

پنجره یازاسـتفادهبامیتوانیدهمچنی ن
Window > Alignقرارصفحهوسطدرراآن

.دهید
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Blendسوم نحوۀ استفاده از ابزار مرحلۀ 

ششمقدم

Textابـزارازاسـتفادهبا Tool (T)کلمه ی
BYEکهیفونتبهراآنفونتسپس.بنویسیدرا

Playfairیعنیکردیماشارهپستابتدایدر
Displayیاندازهوسفیدراآنرن  گ.دهیدتغیی ر

.دهیدتغیی ر445ptبهنی زرافونت

 2۸



Blendسوم نحوۀ استفاده از ابزار مرحلۀ 

هفتمقدم

راستکلیکآنرویبروکردهانتخابرامتن
Createگزینه یوکنـید outlinesانتخابرا
ردهکراستکلیکآنرویبردوبارهسپس.کنـید

.کنیدانتخابراUngroupگزینه یو
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Eraserابزار چهارم نحوۀ استفاده از مرحلۀ 

.کنیمدرستتایپ وگرافیدررادیدیخطایEraserیاپاک کنابزارازاستفـادهبامیخواهیممرحلهای ندر
<ArrangeمنویازوکردهراستکلیکBحرفرویبرابتدا Bring to frontصفحهرویبهراآن

.بیاورید

بابعدوکـنیدکپ یخودمکاندرراآنCtrl+Shift+Vترکیب یکلید هایباوکردهکپ یراYحرفسپس
Eraserابزار Tool (Shift-E)کلمه یزی ربهمیخواهیدکهراحروفازقسمت های یhiکـنیدپاکرابرود.

Eraserابزارباشیدداشتهتوجه Tool (Shift-E)انتخابراآنهاکهمیکندعملاشیائیرویبرتنها
.کـنیدت کرارهمEحرفبرایراکارهمی ن.کرده اید
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Eraserابزار چهارم نحوۀ استفاده از مرحلۀ 

نشانEraserابزاراعمالازبعدراحروفراستسمتشکلواصلیدرحالتراحروفچپسمتشکل
استفـادهآنهارویبرEraserابزارکههستندآنهای یشده اندمشخصزردرن  گباکهقسمت های ی.میدهد

.استشده
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(نحوۀ اضافه کردن سایه)پنجم مرحلۀ 

شدنزیباتربرایمیخواهیمآخرمرحله یدر
عدب  آنبهسایهازاستفادهباتایپ وگرافی

ازوکردهانتخابراسفیدرن  گحروف.بدهیم
باوEffect>Stylize>DropShadowمنوی

.بدهیدسایهآنبهزی رمقادی رازاستفاده
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Blendپایان آموزش تاپ وگرافی با سبک 

مواردماآموزشدرای ن!میگوییمتبریکشمابه.رسیدانتهابههمآموزشایـنترتیببدی ن
:گرفتیمیادرازی ر

GradientاستوانهساختنبرایBlendابزارازاستفادهنحوه ی•

تایپ وگرافییکباGradientاستوانهجایگزینی•

عدبرایسایهکردناضافه• نهای یاثربهدادنب 

خلاقیتEraserابزارازاستفادهدرهمچنی نوکـنیداسـتفادهدیگریکلماتازمیتوانید
.بسازیددیگریهایتایپ وگرافیخودسلیقه یاساسبرودهیدخرجبهبیشتری
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Retroک در ایلاستریتور با سبساخت تایپ وگرافی آموزش 

ودارندیازنثابتیمتنکههستندصورتیبهایلاستریتوردرتایپ وگرافیآموزش هایازخیلی
ایدبجدیدتایپ وگرافییککردندرستبرایومیشودانجاممتنآنرویتغیی راتسپس
بهراآنودادخواهیمانجامراتایپ وگرافیآموزشای ندرولیشودانجاماولازدی زای ن
دلخواهفونتبادلخواهمتنهربرایآنازبتوانیدتاکردخواهیمذخی رهStyleیکصورت

.باشیدهمراهماباکنید؛استفادهخود
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Retroجزییات آموزش تایپ وگرافی با سبک 

ایلاستریتورادوب ی:نرم افزار

Appearance:شدهاستفادهت کنیک هایوابزارها panel,Graphic Style panel,Retro typography

آسان:پیچیدگیدرجه

ساعتنیم:تقریب یشدهتخمی ن زدهزمان

وقدیمینوشته هاییاRetroسبکبهاستافکتیبگی ریمیادهمباآموزشای ندراستقرارکهافکتی
.کردادهاستفپ وسترهایاوتبلیغاتیهایبیلب وردمانندمختلفیجاهایدرمیتوانآنازکهبعدیسه
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پ روژه و متن اولیهساخت -اولقدم 

رمندرجدیدپ روژهیکساختباراکارمان
پ روژهاندازه.میکنیمآغازایلاستریتورافزار

ازپس.استRGBآنرن  گیمدودلخواه
هصفحاندازهبهمستطیلیپ روژهساخت
.بگذاریدf16975راآنرن  گوبکشید
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پ روژه و متن اولیهساخت -اولقدم 

Typeابزارازاستفادهبا tool (T)حرفیک
رایبنی زراخوددلخواهفونتوبنویسیددلخواه

وAحرفازآموزشدرای ن.کـنیدانتخابآن
.استشدهاستفادهMontserratفونت
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Stroke-دوم قدم 

راایدنوشتهکهحرفیفرضپیشFillبایدابتدا
ازAppearanceپنلدرسپسکنـیدحذف

Newگزینهپنلپایی ندکمه های Strokeانتخابرا
حرفبرای5اندازهورن  گسفیدایStrokeوکرده
.بسازیدخود
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Stroke-دوم قدم 

Appearanceپنلالعادهفوقهایقابلیتازیکی
هرهبدلخواهعنصریکبرایمیتوانیدکهاستای ن

باجداگانهStrokeوFillمیخواهیدکهتعداد
رن  گFillیادآوری،جهت).بسازیددلخواهمشخصات

تادورکهاستخطیStrokeوعنصرهردرونی
.میگی ردفراراعنصردور

خودحرفبرایجدیدیStrokeقبلقسمتمانند
درودهیدتغیی ر293454بهراآنرن  گوبسازید

Strokeزی ربهراآنموسباAppearanceپنل
.بکشیدقبلی
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Stroke-دوم قدم 

تنظیماتوافکتمیتوانیدFillوStrokeهربرای
مرحلهدرکهراایStroke.کرداعمالراایجداگانه

افکترهپنجزی رشکلمانندوکردهانتخابساختیدقبل
Transformکنـیدبازآنبرایرا.
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Stroke-دوم قدم 

افزایشپیکسل1بهراگزینهدوهرMoveقسمتدر
کنیـدواردرا2۸ عددهمCopiesقسمتدرودهید

بعدیسهافکتیکوشودکپ یبار2۸ شماStrokeتا
.کنددرستحرفبرای
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و سایه تایپ وگرافی Fill-سومقدم 

پنلدر.کنیمآمی زیرن  گراحرفدرونبایدحالا
Appearanceیکبارای نFillآنرن  گوبسازیدجدید

لایهدوزی ربایدلایهای ن.دهیدتغیی ر39a4beبهرا
Strokeگی ردقرارقبلی.
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سایه تایپ وگرافیو - Fillسومقدم 

یرن  گآب یلایهزی رراآنوبسازیددیگریFillلایه
بهار آنرن  گوبیاوریدساختیدقبلمرحلهدرکه

نی زTransparencyپنلدرودهیدتغیی رمشکی
opacityای ن.دهیدکاهشدرصد2۸ بهراآن

.کنددرستراحرفسایهاستقرارلایه
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سایه تایپ وگرافیو - Fillسومقدم 

بازراTransformپنجرهمشکیلایهای نبرای
زی رشکلمانندرانظرموردتغیی راتوکنید

.ودشدرستحرفسایهنهایتدرتاکـنیداعمال
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سایه تایپ وگرافیو - Fillسومقدم 

درحرفوسایهحاضردرحالکنـیددقتاگر
نای رفعبرای.نیستندیکدیگردقی قامتداد
Offsetمنویمشکل Pathکنیـدبازرا.

38



سایه تایپ وگرافیو - Fillسومقدم 

okودهیدتغیی رپیکسل3بهراOffsetمقدار
تربزرگکمیسایهمیشودباعثکارای ن.کنید
.گی ردقرارحرفStrokeامتداددروشود
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افکت -چهارم قدم 

منر دروکردهدانلودرانقطه ایافکتفای لای ن
آنزادلخواهمورددو.کـنیدبازایلاستریتورافزار

ودبیاوریخودمانپ روژهصفحهبهوکردهکپ یرا
Swatchesواردراهاآنسپس panelکنیـد.

پنلدروکردهکلیکهاآنرویجداگانه
SwatchزینهگAdd new swatchبهتابزنیدرا

.شونداضافهحاضرلیست
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https://blog.spoongraphics.co.uk/wp-content/uploads/freebies/Distressed-Vector-Halftone-Patterns.zip


افکت -چهارم قدم 

وبسازیدجدیدیFillلایهAppearanceپنلدر
هایافکتازیکیSwatchesپنلازباراآن

.کـنیدپ رایدآوردهکهنقطه ای
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افکت -چهارم قدم 

SoftبهراآننوعTransparencyپنلدر
Lightدشخوزی ری نآب یلایه یباتادهیدتغیی ر

.شودترکیبحدودیتا
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پس زمینه و ذخی ره استای ل-پنجم قدم 

پسرن  گصورتیمستطی لبرایFillلایهیک
رپ دیگرنقطه ایافکتباراآنوبسازیدزمینه

کاهشدرصد3۸ بهراآنOpacityوکرده
.دهید
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پس زمینه و ذخی ره استای ل-پنجم قدم 

درتایپ وگرافیاستای لکردنذخی رهبرای
پسسکردهکلیکحرفرویابتدا،ایلاستریتور

Graphicپنل Stylesدکمه هایازوکردهبازرا
لاستای تاکنـیدانتخابراNewگزینهپنلپایی ن

.شودذخی رهجدیداستای لیکعنوانبهشما
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پس زمینه و ذخی ره استای ل-پنجم قدم 

بادخواستیکهرادلخواهیمتنهرمیتوانیدحالا
نلپهمانازسپسوبنویسیددلخواهفونتهر

Graphic Stylesانتخابراخودنظرمورداستای ل
.بسازیدراخودتایپ وگرافیتاکنیـد

تیدخواسکهبارتعدادهروکنـیددی زای نباریک
!کنیـداستفاده
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Retroپایان آموزش ساخت تاپ وگرافی با سبک 

سبکابوی رایشقابلایلاستریتوردرتایپ وگرافیساختآموزش
ساختروشکهحالا.می رسدپایانبهدراینجاRetroقدیمی

رایگریددلخوادتایپ وگرافینوعهرمیتوانیدگرفته ایدیادراآن ها
.کنیـداستفادهآنهاازودهیدانجامسبکهمی نبا
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تایپ وگرافی سبک کمیکآموزش 

کلمهیامتنیکاستقرارآموزشای ندروهستیمخدمتتاندرایلاستریتورنرم افزارازدیگریآموزشبا
کمـیکدارطرفهمشمااگر.کنیمتبدی لبعدیسهحالتبهراآنکمیکسبکبهوکنیمنصفوسطازرا

.ب ودیدخواهعلاقمندکمیکسبکتایپ وگرافیساختیادگی ریبهقطعاهستیدآننوشتارسبکوها
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کمیکجزییات آموزش تایپ وگرافی سبک  

ایلاستریتورادوب ی:نرم افزار

Swatch:شدهاسـتفادهت کنیک هایوابزارها panel, Stroke panel, 3D Design, typography

متوسط:سختیدرجه

دقیقه2۸ :شدهتخمی ن زدهزمان
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(پالت رن  گ)مقدمه 

کهسـتاآندرشدهاستـفادهرنـگپالتکمیک،سبکبهتایپ وگرافیساختقـدم هایمهم تری نازیکی
آموزشسمتقدرای ن.باشدداشتهکمیک هانوشتارسبکبهراشباهتبیشتری نتاشدهانـتخابدقتبه

رنـگپالتخودبـرایچطورهمچنی نوکـنیدمنتقلخـودپ روژهبهرارن  گپالتچطوردادخواهیم
.دهیدادامهخواندنبهدقتباپسبسازیدرادلخواهی
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قدم اول

سیاربکارآن هاازدرستاستفـادهورن  گ هاباکـارحقیقتا.کنیمتعریفراخـودرنـگپالتبایداول
Adobeابزارهایازهمی نبراینیستیمخبرهآندرهنوزهمماواسـتسختی Colorو

Webgradientsرن  گ هایبـرایGradientمیکنیماستفادههاپ روژهدر.
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https://color.adobe.com/
https://webgradients.com/


دومقدم 

دیدکر انتـخابراخودپالتاین کهازبعد
یولکنـیدخـودپ روژهواردرارن  گ هاباید
!دبسازیراپ روژهبایداولکـارای نبرای
نرم افزارپیش فرضفرمت هایازیکی

.نیـدکانتخـابدلخواهبهراایلاستریتور
فرمتوWebفرمتازمثالدرای ن)

(.استشدهاسـتفادهRGBرنـگی
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سومقدم 

تانیدککلیکسطل زبالهکناردکمهبرروی
Swatchپنجره.بسازیدجدیدیرن  گی

هبمیتوانیدآندرکهمیشودبازجدیدی
واردراخودهایرنـگمختلفروش های

مقادی ریاCMYKیاRBGمثلا).کـنید
Hexadesimalغی رهو)

ایرن  گ هتمامیت کبهت کصورت،بدی ن
بهراقبلمرحلهدرشدهانتخاب

Swatchکنـیداضافهخـود.
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کلمهبرش  

نصفراخودکـلمهچطورکهدادخواهیمآموزششمابهبخشای ندر
.یممی پ رداز رنـگ آمی زیبهآنازبعد.بدهیدبعدیسهافکتآنبهکنیـد
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اولقدم -برش کلمه 

Typeابزارازاستـفادهبا tool (T)کلمه
هرازمیتوانید.بنویسیدراخـودنظرمورد

روفحوکـنیداستفـادهمیخواهیدکهفونتی
زامثالایـندر.بنویسیدبزرگیاکوچکرا

Robotoفونت Slabواستشدهاستفاده
.شده اندنوشتهبزرگحروف،تمامی

55

https://fonts.google.com/specimen/Roboto+Slab


قدم دوم-برش کلمه 

ابزارازاسـتفادهباوداریدن  گهراشیفتدکمه
(Selection tool (vدلخواهبهراکلـمهندازها

لیکککلمـهبررویسپس.کنیدبزرگوکوچک
Createگزینهوکنـیدراست outlinesرا

.شودلتبدی شکلبهمتنازتاکنیـدانـتخاب
ترکیب یهایدکمهباراکـارهمی ن

Shift+Ctrl+oدهیدانجاممیتوانیدهم.
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قدم سوم-برش کلمه 

Line(\)ابزارازاستـفادهبا segment toolکندنصفراشمامتنیاکلمهتابکشیدخطی.
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قدم چهارم-برش کلمه 

Windowمنویطری قاز > Pathfinder
ومتن.کنیدبازراPathfinderپنل

انتـخابهمباراکشیده ایدکهخطی
سپس.بزنیدراDivideگزینهوکـنید
ینهگز وکنـیدراستکلیکشکلبرروی

Ungroupعملاترتیببدی ن.بزنیدرا
ازحالاآنت که هایوکرده ایمنصفرامتن

.شده اندجداهم
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قدم پنجم-برش کلمه 

پسسکنیدانتخـابآنهارویبرکردنکلیکوشیفتدکمهداشتنن  گهبارامتنبالای یت که های
ارت کر پایینیهایت کهبـرایراکارهمی ن.شوندگروهت که هاهمهتابزنیدراCtrl+Gترکیب یدکمه های

.کـنید

گها.دهیدتغیی راسـترن  گیپالتدرکهنارنجیبهراآن هارنـگوکنـیدانتخابراگروهدوهرحالا
Selectionابزاربانباشید،ن  گرانشدرن  گهممتنازاضافیت که هایزی رشکلمانند toolراآنها

.کنیـدحذفوکردهانـتخاب
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قدم پنجم-برش کلمه 

.می رویمنمتسه بعدیافکتسراغبهازی نپس.کنیدجداپایینیت کهازخـوددلخواهبهرابالای یت که
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افکت سه بعدیساخت 

بعدیهسافکتقبل،مرحلهدرنصف شدهکمیکسبککـلمهبهمیخواهیمحالا
.ودب خواهدرن  گ آمی زیهمکمیکسبکتایپ وگرافیساختبعدمرحله!بدهیم
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قدم اول–سه بعدی افکت ساخت 

Effectمنویبهوکـنیدانتـخابرات که هاهمه > 3D > Extrude & Bevelزی رعکسبهتوجهبا.بروید
.دهیدتغیی رخوددلخواهبهراDepthگزینهمیتوانید.دهیدتغیی رراشدهبازپنجرهدرورودیمقادی ر

.کنـیدokشدیدراضینتیجهازوقتی.ببینیدراتغیی راتتابزنیدتیکراPreviewگزینه

ایـنکهکنیـدExpandراآنبایدابتدامتنکردنبعدیسهازپسلایههرکردنرنـگوکردنکـاربرای
Objectمنویطری قازکار menu > Expand Appearanceمی شودانجام.
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قدم اول–سه بعدی افکت ساخت 

63



قدم دوم–سه بعدی افکت ساخت 

راگ.کنیدانتخـابراکلـمهجانب یقسمت های
داشتهدسترسیآن هابهکلیکیکبانتوانستید

تدااببایدوهستندگروهآنهاهمهیعنیباشید
.بزنیدراUngroupگزینهوکـنیدراستکلیک

قسمت های)جانب یقسمت هایانتخابازبعد
پنلبهجداجداکلمـههربـرای(پ ررن  گ

PathfinderگزینهوبرویدUniteانـتخابرا
.شوندتبدی لت کهیکبهجدات که هایآنتاکنـید

.کنیـدت کرارجانب یقسمت هایتمامبرایراکـارهمی ن
64



قدم سوم–سه بعدی افکت ساخت 

مناسبرن  گپ ر نارنجیبهراآنهارن  گوکنیدانتـخابراکردیداصلاحقبلقسمتدرکهراپ ررن  گیت که های
رامت هاقسازیکیکهاستای نکارانجامبـرایسری عراهیک.دهیدتغیی رب ودرنـگپالتدرکهکمیک،

Selectمنویبهوکـنیدانتخـاب > Same > Fill Colorتمامکهمی شودباعثکـارایـن.بروید
.شوندانتخابهمهستندشدهانتخابت کههم رن  گکهشکل های ی

اولهکن  کنیدفراموشولیدهیدتغیی رخوددلخواهبهرات که هابی نفاصلهمیتوانیدهممرحلهای ندر
ازیابزنیدراGroupوکنیدراستکلیککنیـد،انـتخابرانظرموردت که های).کنـیدGroupراآنها

)کـنیداستفـادهCtrl+Gترکیب یدکمه های
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قدم سوم–سه بعدی افکت ساخت 
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قدم چهارم–سه بعدی افکت ساخت 

.دهیدتغیی رمشکیرنـگبهراآنهاStrokeوکنـیدانتخا  براکلمههمه
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قدم پنجم–سه بعدی افکت ساخت 

ونرسندهمبهکاملزی رشکلمانندهمشماکـلمههایگوشهاسـتممکنStrokeاعمالازبعد
.باشندداشتهعجیب یشکل
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قدم پنجم–سه بعدی افکت ساخت 

سرتاکنیـدانـتخابرادومگزینهCornersقسمتدروبرویدStrokeپنلبهمشکلای ناصلاحبرای
.شودگردگوشه ها
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قدم پنجم–سه بعدی افکت ساخت 

.شودزی رتصوی رمانندچی زینتیجهبایدمرحلهای نپایاندر
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(بک گراند)آخر مرحله 

قرارمی کنیمدرستکهبک گراندیدرراآنوکنیمدرستسایهکلـمهبـرایمیخواهیممرحلهای ندر
!استنماندهکارپایانبهچی زی.بدهیم
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بک گراند

راکلمـههمهاولکاری،هرانجامازقبل
بهی لمستطیکحالا.کـنیدگروهوکنیدانتـخاب

آب یهبراآنرن  گوکنـیدرسمپ روژهصفحهاندازه
برروی.دهیدتغیی رپالتدرموجودکمرن  گ  تر

Arrangeگزینهوکنیـدراستکلیکمستطی ل
> Send to backبهمستطی لتاکنیدانتخـابرا

.برودکلمهزی ر
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یکآخری ن قدم در ساخت و طراحی تایپ وگرافی سبک کم

انتخابراکـلمهدارید،ن  گهراAltدکمه
درستکلـمهازکپ ییکتابکشیدوکـنید
التپدرپ ررن  گآب یبهراکپ یرنـگ.کنـید
.کنیـدحذفراآنStrokeودهیدتغیی ر

مستطی لبی نراسایهLayersپنلاز
نهاتحالا.بگذاریداصلیکلمـهوبک گراند

کاملدی زای نوکنیدتنظیمراآنمکانباید
.می شود
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یکپایان آموزش ساخت تایپ وگرافی به سبک کم

!بگذاریدتراکاشبهماباراکارتاننتیجه.می رسدپایانبهاینجادرکمیکسبکتایپ وگرافیساختآموزش
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